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Modellus web page and support
For updated information see

http://phoenix.sce.fct.unl.pt/modellus 

For email support and information, send an email to

modellus@mail.fct.unl.pt
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Sample files, images and videos

The Modellus sample files have been provided by many colleagues. Most are

identified with the author’s name, except those created by Modellus authors.

The video files are used with permission from

Pasco Scientific (http://www.pasco.com) and

VideoPoint (http://www.lsw.com/videopoint).

You can browse the images and video files

following the appropriate links on the Modellus

CD.

Click to see an image in 1:1 size.

Use the right button to save an

image on a folfer.

Click to play the video.



10

Modellus Manual version 2.5 (2002)

blank page



11

Modellus Manual version 2.5 (2002)

Introduction

Building and exploring mathematical models is a fundamental task in science. Modellus offers

students and teachers a "minds-on," multilevel learning experience in which they create,

simulate, and analyze models interactively on the computer, either from experimental data and

images or from pure theoretical thinking.

Modellus is software for interactive modelling with mathematics. Teachers and students can

use Modellus to build mathematical models and explore them as animations, graphs, and tables.

Instead of just looking at algebraic, differential, and iterative equations, Modellus users can

experiment visually and interactively with models and animations to better understand the

underlying mathematics and the multiple representations of a model.

Modellus can also be used as a tool to analyse and make sense of experimental data,

providing tools to make models from images (photos, graphs, etc., in BMP or GIF format) and

videos (AVI format).

Modellus can be integrated in any elementary course of mathematics or physical sciences or in any

advanced course that makes use of functions, differential equations, iterations, etc.

Users can:

Select ready-to-use models from the library of

models that come with Modellus or download them

from the web page.

Quickly customize existing models to meet specific

needs.

Create their own library of reusable models.

Preserve the integrity of models by password

protection.

Modellus gives teachers and students a powerful technology

for learning mathematics and science at secondary

school and college level.

"Scientific computation has become so much a part of everyday experience of scientific and

engineering practice that it can be considered a third fundamental methodology of science—

parallel to the more established paradigms of experimental and theoretical science."

National Research Council, National Academy of Sciences (USA)
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“To create a world and watch it evolve is a
remarkable experience. It can teach one what
it means to have a model of reality, which is to
say what it is to think. It can show both how
good and how bad such models can be. And by
becoming a game played for its own sake it can
be a beginning of purely theoretical thinking
about forms.”

Jon Ogborn

Modellus Manual version 2.5 (2002)
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Installing and launching
BASIC

1

1 Place the CD (with an auto run
for the index.htm file), select the
link Install Modellus and
choose the version you want to
install.

2 Use, preferably, the directory
c:\Program files\modellus as
the destination folder.

3 A Modellus file can be launched
from the file with a double click
only if Modellus is not running.

4 A Modellus file can also be
launched from a link in an HTML
browser only if Modellus is not
running.

Where to start

Load the file

01 a car accel with a function.mdl

in the Tutorial folder. Read and

examine it carefully. Then run it. Look

at model 

02 derivatives.mdl 

in the same folder. And so on...

You can also choose Workshops and

Help from the Help menu. Then choose

one of the four workshops.
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Windows and menus
BASIC

2

Control window

Notes window

File menu Edit menu Case menu Window menu Help menu

Model window

Animation window

Graph window
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Writing and running a model
BASIC

3

1 Write the model
in the Model
window.
Use * (or the
space bar) to
get the
multiplication
operator.

2 Press
Interpret.

3 Give a value
to the
parameter
v. All values
in this
window
must be
numeric.

4 Run the model. The
independent variable, t,
has domain [0, 20] units.

The Initial Conditions

window appears when

there are parameters or

initial values.
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Creating new windows and viewing
multiple representations of a model

BASIC

4

Window menu

Press Adjust to fit

the graph.

Drag or Ctrl + Click

to select variables.
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Control window
BASIC

5

Control window

Replay/pause

Symbol and current value for the

independent variable

Go to last

calculated value
One step

backward

Drag to browse in

the domain

One step

forwardGo to first value

Stop

Run / pause

Independent variable step

Independent variable limits

Angles in degrees or radians

Numbers output format

Check to create iterative

models, without Independent

variable.

Check to run the file

automatically after loaded.

Independent variable letter
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Viewing multiple cases
BASIC

6

1 Choose Add
from the Case
Menu to add a
case. The
maximum
number of
cases is 5.

Use also this
menu to
delete a case.

2 Give
different
values to the
parameter v.

3 Run the model and select the
colour of the cases you want to
see. In the Graph window, it is
possible to see multiple cases
simultaneously. In the Table and
Animation windows, only one
case can be seen.
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Creating an animation
BASIC

7

Windows menu

1 Click the Particle
button.

2 Click anywhere in
the Animation
window.

3 Select x as the
horizontal
coordinate for the
particle.

4 Check tracking.

5 Give the name
Car to this
particle in the
Name box.

6 Click OK and run
the model.
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Creating a vector in the Animation
window

BASIC
88

1 Click the Vector
button.

2 Click anywhere in
the Animation
window.

3 Select v as the
horizontal
component of the
vector.

4 Change the
horizontal scale to
0.1

5 Uncheck Axis.

6 Change Thickness
to 3 and Colour to
red.

7 In the Name box,
write v.

8 Click OK and run
the model.
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Linking a vector to a particle
BASIC

9

1 Drag the tail of
the vector on the
particle.

2 Answer Yes to the
question Link to…

3 Run the model.
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Editing the properties of an object in
the Animation window

BASIC

10

1 Click on the
particle with the
RIGHT button.

2 Answer Yes or No
to choose which
object to edit.

3 Change the scale
of the horizontal
coordinate of the
particle to 0.5.

4 Click OK and run
the model.
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Creating a level indicator in the
Animation window

BASIC

11

1 Click on the Level
Indicator button.

2 Click anywhere in
the Animation
window.

3 Select the
variable v to be
displayed in the
level indicator or
bar.

4 Set the maximum
to 20.

5 Click OK and run
the model.
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Creating an analog meter in the
Animation window

BASIC

12

1 Click on the
Analog Meter
button.

2 Click anywhere in
the Animation
window.

3 Select the
variable v to be
displayed in the
level indicator or
bar.

4 Set the maximum
to 10.

5 Click OK and run
the model.
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Creating and editing a graph in the
Animation window

BASIC

13

1 Click on the
Graph button.

2 Click anywhere in
the Animation
window.

3 Select the
variable t to be
displayed in the
horizontal axis
and the variable x
to be displayed in
the vertical axis. 

4 Change Colour
and Thickness.

5 Click OK and run
the model.

6 Click with the
RIGHT button on
the origin of the
graph (or on the
pencil).

7 Change the
horizontal scale to
0.2, and run the
model again.
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Creating a digital meter in the
Animation window

BASIC

14

1 Click on the
Digital Meter
button.

2 Click anywhere in
the Animation
window.

3 Select the
variable x to
appear in the
digital meter. 

4 Change Font… to
Size 16.

5 Click OK and run
the model.
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Inserting images in the Animation
window

BASIC

15

1 Click on the
Image Importer
button.

2 Click in the
Animation
window.

3 Select x as the
horizontal
coordinate of the
image.

4 Change the scale
of the horizontal
coordinate to 0.5.

5 Select the file
(BMP or GIF) to
use.

6 Click OK and run
the model.
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Inserting text in the Animation
window

BASIC

16

1 Click on the Text
button.

2 Click in the
Animation
window.

3 Write the text in
the Text box.

4 Select x as the
horizontal
coordinate of the
text.

5 Change the scale
of the horizontal
coordinate to 0.5.

6 Change the
colour.

7 Click OK and run
the model.

32
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Creating a geometric object in the
Animation window

BASIC

17

1 Click on the
Geometric Object
button.

2 Click in the
Animation window.

3 Select Type Circle.

4 Change Colour and
Thickness.

5 Click Placement…

6 Select Center on
coordinates [0, 0]
and Point on [x,
0].

7 Click OK and run
the model.
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Getting help
BASIC

18

Help Menu

1 The Help file has four
Workshops that introduce
many of the features of
Modellus. You can read
them and follow the
instructions.

2 The second part of the Help
file is a hypertext
manual. The initial
sections are concise and
direct and the final sections
are more complete. The
Syntax (Reference)
section is useful for a quick
check of the syntax of a
function or of a conditional
statement.

3 Use the Show button to
look for a specific word (on
the Search tab) or topic
(Index tab).
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INTERMEDIATE
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Model syntax
INTERMEDIATE

1

You can open only one Model window at a time.

A model may have variables, functions,

differential equations, iterations and

conditions. 

Variables appear in green italic. Numbers appear

in regular text and portions that it interprets as

function names (e.g., sin, cos, etc.) and logical

conditions (if, then, and, or) appear in bold.

Any set of alphanumeric characters (the letters a

through z and the numbers 0 through 9, or the

underscore character _ ), starting with a letter

(e.g.: F2_x) can be used to define a variable.

Modellus is case-sensitive, so T is different from t.

By default, the independent variable is t. It can

be changed to any other letter, using the

Options... button in the Control window.

The left hand side of an equation can only have one variable. E.g.:

In this model, a and b are considered as parameters. The initial values for the parameters are

given in the Initial Conditions window.

A line can have only a name of an independent variable. E.g.:

This is useful in many situations. For example, to create geometric images than can be directly

manipulated.
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Mathematical operators
INTERMEDIATE

2

Addition + 

Subtraction - 

Multiplication * (or press the space bar)

Division /

To enter a fraction, type the numerator, followed by the slash character ( / ), and then type the

denominator. For example, type (2*P)/T to enter the fraction

If the numerator or denominator is an expression, enclose the expression in parentheses.

Tool palette

Exponent ^

Square root #

π $

e e

Delta x (change in x) %

Non-defined value for x ~

Last-value of x ‘

If the argument of the square root (or of the exponent) is an expression, enclose the expression in
parentheses.

For example, type displ=#(dispx^2+dispy^2) to enter

Requires a variable, not an expression. To
compute the rates of change of two variables,
divide the change in one variable by the change
in the other variable.

Requires a variable, not an expression.

If the argument of the square root is an
expression, enclose the expression in
parentheses.
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Editing equations and inserting
comments

INTERMEDIATE

3

Editing equations

Use the standard keys for editing: Backspace, Delete, Home, End, and arrow keys. If you make a

mistake and want to start over, you can clear the Model window of its contents by choosing New

from the File menu.

Copying and pasting

Use the Cut, Copy, and Paste commands on the Edit menu to cut, copy, and paste equations within

the same model, from model to model, or into another program. 

You can also copy an equation you typed in a word processing application and paste it into the

Modellus Model window, as long as the equation contains the characters that Modellus recognises.

For the best result when copying equations into another application, use Copy Window. Otherwise,

some characters might be displayed differently. For example, in the Model window, Modellus

interprets the "$" character as pi (=3.14159…). However, when you paste the equation  into

another application, you’ll see "$".

Inserting comments

Type a semicolon at the beginning of a comment line. (Modellus ignores commented lines.) For

example:

Enter only one statement per line.
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Pre-defined functions and
conditions. Imaginary numbers 

INTERMEDIATE

4

Pre-defined functions and conditional statements appear in bold:

For a complete list of the pre-defined functions and conditional statements, see the Reference

section of this manual or the Modellus help file.

Imaginary numbers

When Modellus finds an imaginary number in any variable, it does the following:

• When the variable appears in a Graph window, Modellus does not plot the number.

• When the variable appears in an Animation window, Modellus displays the number like
this: 

• When the variable appears in a Table window, Modellus displays the number like this:
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Control window
INTERMEDIATE

5

In the Control window you can:

• Run or pause  the model.

• Stop  the model.

• Rewind  the model, without losing
calculated values.

• Jump  to the last value of the model.

• Replay  the model.

• Read  the current value of the
independent variable and the limits of its domains.

• Drag  the current
value of the independent variable and check visually
the progress of the variable.

• Go backward   or forward  a single step.

• Access the Options… dialog box:

Use the Options… dialog box to:

• Set the limits and the step of the independent
variable.

• Choose the angle unit.

• Format all numbers in tables, graphs, animations, and in
the Initial Conditions window.

• Change the model type from standard (with an explicit
independent variable) to an iterative model, without explicit
independent variable.

• Check/uncheck to auto-run when loading the model.
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Modellus files and imported images
and videos. The Preferences dialog

box

INTERMEDIATE

6

Modellus files have an “mdl” extension. The filename must be a valid Windows filename:

e.g., it can’t use symbols like “\ * < > : / ?”.

Modellus files can be launched locally from a web browser or other software with a

hyperlink if, and only if, Modellus is not running.

GIF and BMP images can

be used in the Animation

window. In the

background of the

Animation window, it can

be placed a GIF or a BMP

image, or an AVI video. An

AVI video appears as a

duplicate image: the left

is the original video where

nothing can be placed over

it. The right is a copy of the

left image, where

annotations and measures

can be made.

It is recommended to keep

these external files in one or more folders on the Modellus folder. The File menu has an

option, "Preferences…", where these folders can be specified as default folders for

images. This will make it easier to

Modellus to locate the files, if any

path name problem arises.
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Image masks
INTERMEDIATE

7

Some of the images used with Modellus are accompanied by a second image with a similar

filename but with the letter "m" tagged onto the end of the filename. For instance, a filename

"ball.gif" can be accompanied by a filename "ballm.gif". Modellus reads the second file as a mask

file. Mask files enable you to mask away portions of a picture that you want invisible. To find out

more about masks, read a computer graphics reference/book.

Example of an image with a mask:

ballm.gif

ball.gif

A sequence of images with names like "natal.bmp", "natal1.bmp", "natal2.bmp", etc.,

can be used to animate an image when file "natal.gif" is placed in the Animation window as a

particle:

natal.bmp

natal1.bmp

natal2.bmp
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Password protection
INTERMEDIATE

8

To maintain simulation and experimental integrity or to hide certain details from students or other

users, you can protect a model by giving it a password. Before assigning the password, you can

hide or display the Model window and/or visual representation windows so that users see only

what you want them to see. Users cannot open or hide any window after the password is

assigned. Users cannot close any windows that are displayed after the password is assigned.

For example, if you want the users of your model to see it represented as an animation and a

graph, but not as an equation, hide the Model window before you assign a password.  

To assign a password choose Password from the File menu:

Type the password in both text boxes. Keep in mind that the password is case-sensitive. Click

OK. Save the model.

You also use the Password command to remove password protection from a previously protected

model:

• Open the file that contains the model with the password you want to remove.

• Choose Password from the File menu. The Password Removal dialog box appears.

• Type the password that was assigned to the model. Click OK. The model is no longer
password protected
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Common buttons and shortcuts
INTERMEDIATE

9

The following buttons are common to most windows:

Hide the window. Useful to customize environments. When you want to see the

window again, open the Window menu and choose the window you want to view.

The window reappears on your screen.

Whenever you open a new Graph, Animation, or Table window, all hidden windows

reappear.

Copy the window content to the clipboard. In the Model, Graph, and Animation

windows, the button copies the content as an image. In the Table window, it copies

the content as a table of data. And in the Notes and Model windows (selected text),

it copies the content as text. Text can also be pasted in Model and Notes windows. 

Print the window content.

Copy and Paste to a word processor may yield better results (and comments can

easily be added in the word processor file).

The hide button doesn’t close the window, it only hides it. To close a window, use the close button

on the top right of the window (Model, Notes, Initial Conditions and Control windows can’t be
closed).

All Modellus menus are accessible with ALT + keys shortcuts. Cut, Copy, Paste text, and Undo,
have direct shortcuts: Ctrl + X, Ctrl + C, Ctrl + V, and Ctrl + Z in the Model and Notes windows.



46

Modellus Manual version 2.5 (2002)

Initial Conditions window
INTERMEDIATE

10

All data in the Initial Conditions window must be numeric.

If necessary, use the separator bar to resize the window

space available for the parameters and the initial values.

If a number appears as 0.00 and its value is, for example,

0.004, it is necessary to change the number of decimal

places in the output, using the Options… button of the

Control window. This change is also valid for all output

(Graphs, Tables, and Animations).

Separator bar

Formats all numbers in the

Initial Conditions window

and in the output windows

(Graph, Table and

Animation)
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Notes window
INTERMEDIATE

11

The Notes window can be used to register comments and/or write instructions to use the model. 

When the model is protected by a password, the user can’t change the content of the window, but

can copy it.

The maximum number of characters in the window is about 3200 — about 2 pages.

You can copy text to and from the Notes window, using the Edit menu or the shortcuts.
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Graph window
INTERMEDIATE

12

A Graph window can show any variable or parameter as graph. To view the model as a graph,

choose New Graph from the Window menu. You can open up to three Graph windows per

model.

The variables are selected in the Vertical list box. To choose more than one variable, drag the

mouse over adjacent variables. To choose non-adjacent variables, use Ctrl + click.

The Horizontal combo box lists the horizontal variable. By default, the selected variable is the

independent one, but any variable can be chosen.

The coloured buttons allow the selection of one or more cases. 
Colours match the different cases, not variables.

The Adjust button automatically adjusts the scales for a best fit in the available space, for the

current domain and counter domain.

The Options… button opens a dialogue box to change graph properties. See next page.
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Options in the Graph window. Zoom
and copy

INTERMEDIATE

13

The Options… button of the Graph window

opens a dialogue box to change graph

properties.

Use the Automatic scale check box to turn

the automatic scale on and off. When

selected, the graph auto-adjusts. This check

box is unselected after zooming in a graph.

Projection lines show or hide dotted lines to

axes.

Tangent lines when replaying show or hide tangents in the graph

when the replay button in the Control window is pressed.

Equal scales force a mono-metric scale.

Points switch the graph between points and lines.

The Limits box is useful for displaying specific parts of a graph.

To change the position of the origin (the intersection of the vertical and horizontal axes) in the

window, double-click on the graph. Double-clicking causes the

origin to move to the mouse position.

To magnify a region of the graph, you can "zoom in" the region of

interest. Press the left mouse button while dragging over the region

you want to see more closely. When the bounding box that appears

encloses the region you want to magnify, release the mouse button.

To return the focus to the view you had before you zoomed in, click

the Adjust button (when you use the zoom feature, Modellus turns

off automatic scaling).

To copy the entire contents of the Graph window as an image

and paste it into another application, choose Copy Window from

the Edit menu or click the copy button at the top right of the

Graph window. The graph is pasted with the names of the

variables near the axes.

49
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Table window
INTERMEDIATE

14

To view the model as a table, choose New Table from the Window menu.

You can open up to three Table windows per model.

Notice that Modellus gives you helpful information at the bottom of the window. To select several

variables at once, hold down the Control key while you’re selecting. In the following illustration,

a column of values appears for each variable selected.

Click the Case buttons at the top left of the Table window to view the data sets you specified for

various parameters. You can view one case at a time.

To copy data from a Table window and paste it into an application (spreadsheet , word processor,

etc.), choose Copy from the Edit menu or click the copy button at the top right of the Table

window. The data appears in columnar format, with the variable name at the top.
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Animation window structure
INTERMEDIATE

15

To create an animation, choose New Animation from the Window menu. Notice that as you

move the mouse over tools and buttons, Modellus gives you helpful tips at the bottom of the

window.

You can open up to three Animation windows per model.

The left buttons are used to create objects in the animation, controlled by the variables.

The top central buttons are tools for making measurements from still images (GIF or BMP) or

video (AVI), which can be placed in the background, using the background button. 

A grid can be switched on and off using the grid button. Clicking the background button, you can

define the grid spacing and colour, as well as the background colour.

Tools to create

animated

objects

Grid on/off

Background

button

Tools to make measurements
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Animation window grid and
background

INTERMEDIATE

16

A grid is very helpful for

positioning objects

precisely. To define the grid,

click the Background button

to open the Background

dialog box (where you define

the grid).

Choose a colour for the grid

lines from the Grid (colour)

pop-up menu.

Specify the spacing between

grid lines by typing a value in

the Spacing text box.

You can switch the grid on and

off by clicking the Grid button

at the top of the Animation

window.

To specify the background for the animation

click the Background button. 

In the dialog box that appears, select one type

of background: Colour, Image/Video, or Stars.

To specify a colour, choose from the Colour pop-

up menu.

To specify an image (BMP or GIF files), or a

video (AVI file), type or browse for the name of

the image file to use.

Modellus imports the image by reference. Any change to the pathname you specified when the

image was imported will break the link to the referenced file.

Note: If you want to use an image or a starfield as background, choose these after you’ve finished

with the grid. When the grid is on, Modellus turns off stars and image backgrounds and defaults to

a colour background.
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Adding, moving and editing objects
in the Animation window

INTERMEDIATE

17

Use the toolbar on the left side of the window to add objects to the animation. When you move

the mouse over a tool button, a tip about that tool is displayed at the bottom of the window. 

Modellus default is the Pointer/Edit tool , except when you click another tool in the toolbar.

To add an object, click a tool in the toolbar. Then click in the Animation window to position the
object where you want it to appear. When you move the mouse pointer into the window, the
pointer changes to +, together with a picture of the tool you’re using. As soon as you release the
mouse button, Modellus defaults to the Pointer/Edit tool and displays a properties dialog box.

In the object dialog box, specify properties (such as variable assignment, colour, or type) for the
object you’re adding.

When you click OK or Cancel, the object appears in the Animation window.
With the exception of text, the objects you add to an animation function as output devices by
default. (Output devices display values reported by the simulation.) You can use an object as an
input device by assigning to it a parameter that you can interactively alter during simulation.

To open an object’s properties dialog box, right-click an object.

To delete an object, click Delete at the bottom of the object’s properties dialog box.

To duplicate an object, drag it with the Ctrl key pressed (except for Geometrical Objects).

When the Pointer/Edit tool is active, you can reposition objects in the Animation window or

resize level indicators, analogue meters, and text using the left button.

Resize pointer

Reposition pointer
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Types of animated objects in the
Animation window
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Use this tool

Particle 

Vector 

Level Indicator 

Analogue Meter 

Plotter 

Digital Meter 

Image Importer 

Text 

Geometric Object 

To add

Image, ball (particle), rectangle, or referential

Vector with or without arrow, resultant, or

components

Vertical or horizontal slider bar

Gauge, clock, or protractor meters

Interactive plotter for drawing line or point plots

Digital meter, with or without the name of a variable

Bitmap image (BMP or GIF format)

Text with the colour, font, style, and size that you

specify

Lines and shapes such as circles and polygons
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Scale factors in the Animation
window

INTERMEDIATE

19

When changes in the values that control an object’s position are very small, they may not show up

in the animation. To make small changes in values visible in the Animation window, modify the

scale factor. For example, to magnify the effect of a change by a factor of 20, specify a scale

factor of 0.05.

If the range in values is very large (for example, from 0 to 500), then enter a scale factor of 5 to

display the range.
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Attaching objects and releasing
attached objects

INTERMEDIATE

20

To join two objects, just place one object on top of the other.

For example, to attach a vector (named “velocity”) to a ball (named

“greenball”), drag a Vector on top of the ball.

When you do this, you’ll see the picture of a knot. Click the left

mouse button.

In the prompt box that appears, click Yes. The vector and ball are now attached.You can move

them around the window while they are joined.

You can attach the following objects to one another:

• particle (ball, rectangle, referential);

• vector;

• digital meter;

• text;

• geometric object.

Note: When joining objects, it is useful to give

them meaningful names. Named objects are

easier to edit and keep track of.

To release the vector from the ball in the

preceding example, right-click the joined

objects.

When prompted to edit object: “greenball”, click

No. When prompted to edit object: “velocity”, click Yes.

The Vector properties dialog box appears.  At the top of the dialog box, Modellus shows you the

name of the object the vector is attached to. In the Vector properties dialog box, click the Release

button, and then click OK. Modellus releases the attachment between the objects.

When you release one object from another, first identify the object from which the attachment was

initiated. For example, if you attached a vector to a ball, you must release the vector from the ball,

as described in the preceding steps.

Note: If the Release button is disabled in the object’s properties dialog box, then the attachment

was not initiated from that object.
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Copying animations
INTERMEDIATE

21

To copy the entire contents of the Animation window as an image and paste it into another

application, choose Copy Window from the Edit menu or click the Copy button at the top right of

the Animation window.

After pasting in Word:
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Interacting with objects in the
Animation window

INTERMEDIATE

22

While the simulation is running, you can affect the results by interacting with the variables

that control objects in the Animation window.

For example, you can create an

interactive level indicator for a

variable and use the level indicator

during simulation to alter the

variable.

With a single mouse click, you can change the value assigned to a Digital Meter. During an

animated simulation, simply grab the Digital Meter object, and then click the left mouse button.

Modellus pauses the simulation and opens the Value dialog box.

Type the new value in the text box.

Click OK

The simulation resumes play, using

the new value you entered.
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Measurement tools in the Animation
window

INTERMEDIATE

23

Select a tool and then click with the left button to start measuring. Keep clicking with the left

button to proceed with the measurement. End the measurement by clicking with the right button.

After creating a measuring tool, you can adjust

the points of the tool with the left button.

To edit or delete a measuring tool, use the

right button. When a tool is edited, its scale and

colour can be changed.

Measures coordinates (x, y).

Measures distance.

Measures distance over path.

Measures area.

Measures slope.

Measures angles. Edit to toggle between degrees and

radians.
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Computing derivatives
ADVANCED

1

To compute a first-order derivative or a partial derivative of a known function, the function must

precede the derivative. Derivatives are computed symbolically.

In the following example:

"u=dx/dt" is not parsed as a derivative and yields two new variables, "dx" and "dt."

The correct syntax is

To compute a derivative or a partial derivative of expression y with respect to variable x, the

variable x must be explicitly stated in expression y. In the following example:

"z=dy/dx" is treated as a derivative and yields z, which equals 1. However, "z=dy/da" will not

parsed as a derivative and yields two new variables, "dy" and "da."
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Differential equations
ADVANCED

2

Write differential equations as instantaneous rates of change equal to some expression, variable,

or parameter. For example:

To use higher-order differential equations, you must specify each rate of change on a separate line.

For example:

Modellus solves differential equations using Runge-Kutta fourth-order method with a default

step of 0.1, which results in exact solutions for many equations. If necessary (for example with

high-frequency or "stiff" systems), reduce the time step in the Options… button of the Control

window.
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Iterative models
ADVANCED

3

The following is a valid iterative model:

To insert the "last" operator click or use the key " ’ ".

After entering the iterative model, you need to assign values to parameters and to the initial

values of variables that iterate. In this case, you need to assign an initial value for n, in the Initial

Conditions window.

It is convenient to check the box "Iterative Model" in the "Options…" button of the Control

Window, in particular if you want to use t as an iterated variable on the model.

An iterative model is computed sequentially.

The following is an iterative model that illustrates Euler method for an oscillator:
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Pre-defined functions
REFERENCE

1

Function

Square root

Sine

Co-sine

Tangent

Secant

Co-secant

Co-tangent

Arc sine

Arc co-sine

Arc tangent

Natural logarithm

Decimal logarithm

Hyperbolic sine

Hyperbolic co-sine

Hyperbolic tangent

Random number

Integer random number

Absolute value

Smallest integer

Rounding

Factorial

Sign

−

+

  

+
2

  

−
2

Example

sqrt(2)

sin(w*t) 

cos(w*t)

tan(5)

sec(2)

cosec(a)

cotan(a)

arcsin(0.5)

arccos(0.5)

arctan(0.5)

ln(5)

log(10)

sinh(t)

cosh(t)

tanh(t)

rnd(10)

Generates a random number between 0 and 10.

irnd(10)

Generates a random integer from 1 to 10.

abs(-5)

int(5.3). 

The result is 5.

round(a)

fact(5)

sign(a)

If a < 0, then sign(a) = - 1

If a > 0, then sign(a) = 1

If a = 0, then sign(a) = 0.
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Conditions
REFERENCE

2

if(t<10) then (a=0.5) If the variable t is less than 10, then the variable a is 0.5. If

there is no other control statement, the variable a will always

be 0.5.

Example Description

if(t>10) then (a=0.5) If the variable t is greater than 10, then the variable a is 0.5.

if(t<>10) then (a=0.2) If the variable t is different from 10, then the variable a

is 0.2.

if(t>=1) then (a=0.2) If the variable t is greater than or equal to 1, then the

variable a is 0.2.

if(t==1) then (a=0.5) When t is 1, a is 0.5.

if(t<=1) then (a=0.2) If the variable t is less than or equal to 1, then the variable a

is 0.2. If there is no other control statement, the variable a

will always be 0.2.

if((t>1) and (r<5)) then (a=0.2) If the variable t is greater than 1 and the variable r is less

than 5, then the variable a is 0.2.

if((t>1) or (r<5)) then (a=0.2) If the variable t is greater than 1 or the variable r is less than

5, then the variable a is 0.2.

if(y<0) then (a=stop(t)) Stops the execution of the model when y<0 and the current

value of t is assigned to a.

if(t==5) then (a=pause(t)) Pauses the execution of the model when t=5 and the current

value of t is assigned to a. To continue the execution, press

the pause button in the Control Window.

if(t==5) then (a=pause2(10)) Pauses the execution of the model when t=5 and the value

10 is assigned to a. The model is suspended for 10 time units

(approximately 10 tenths of a second).

If the variable switch is equal

to 0 then lambda is equal to …

and b is 5.

If the variable switch is equal

to 1 then lambda is equal to

wavelength and b is 10.

if(switch==0) then (lambda=wavelength × ) and (b=5)

if(switch==1) then (lambda=wavelength) and (b=10)

  

1

1− 2
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Particle object properties I
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To specify

The variable that controls the particle’s

horizontal movement 

The variable that controls the particle’s

vertical movement

The scale of the particle’s horizontal or

vertical movement on the screen

The variable that controls the horizontal

position of the origin of the particle’s axis

The variable that controls the vertical

position of the origin of the particle’s axis

Type of object to add (image or object)

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Type a value in the appropriate Scale text box.

Click the Origin checkbox.

Under Origin, select the appropriate variable in

the Horizontal list box.

Click the Origin checkbox.

Under Origin, select the appropriate variable in

the Vertical list box.

If image, click Image and then type or browse for

the name of the file to import. (Modellus uses BMP

and GIF formats.)

If object, click Object and then choose the object

type from the pop-up menu. Then choose a colour

for the particle from the Object (colour) pop-up

menu.



Do this

To change the default name Modellus assigns

to the particle, type a new name in the Name

text box.

Giving objects meaningful names is particularly

useful when joining objects. 

Toggle the Name attribute checkbox to show or

hide labels, such as the names of variables.

Toggle the Value attribute checkbox to show or

hide labels, such as the values on the axes of a

ball’s referential.

Toggle the Axis attribute checkbox to show or

hide the object’s axes.

Toggle the Trajectory attribute checkbox to

show or hide the object’s trajectory.

Click the Tracking checkbox.

Type the number of steps in the text box.

Tracking is associated with the time step

specified in the Control Options dialog box

Each image frame in the track is equivalent to

a time step. For example, if the time

step is set at 0.1 and you specify

tracking at every 10 steps, then

Modellus will show one image per

second. 
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Particle object properties II
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To specify

Particle object’s name

Name labels

Value labels

Axis

Trajectory

Tracking, which causes Modellus to display

a trail of image frames at the interval you

specify
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Vector properties I
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To specify

The variable that controls the magnitude of

the vector’s horizontal component

The variable that controls the magnitude of

the vector’s vertical component

The scale of the vector’s horizontal and

vertical components

The variable that controls the horizontal

position of the origin of the vector’s axis 

The variable that controls the vertical position

of the origin of the vector’s axis 

Colour

Thickness of the vector

Vector’s name

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Type a value in the appropriate Scale text box. 

Under Origin, select the appropriate variable in

the Horizontal list box.

Under Origin, select the appropriate variable in

the Vertical list box.

Choose a colour for the vector from the Colour

pop-up menu.

Choose a thickness from the Thickness pop-up

menu.

To change the default name Modellus assigns to

the vector, type a new name in the Name text

box. 

Giving vectors meaningful names is particularly

useful when joining objects. 
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Vector properties II
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To specify

Name labels

Value labels

Axis

Vector with an arrow 

Tracking, which causes Modellus to display a

trail of image frames at the interval you

specify

Representation of vector

Do this

Toggle the Name attribute checkbox to show or

hide labels, such as the names of the vector’s

components.

Toggle the Value attribute checkbox to show or

hide labels, such as the values of variables that

control the vector.

Toggle the Axis attribute checkbox to show or

hide the vector’s axes.

Select the Arrow attribute.

Click the Tracking checkbox.

Type the number of steps in the text box.

Tracking is associated with the time step

specified in the Control Options dialog box. Each

image frame in the track is equivalent to a time

step. For example, if the time step is set at 0.1

and you specify tracking at every 10 steps, then

Modellus will show one image per second. 

Select Components to represent the vector as its

components. 
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Level indicator properties
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To specify

The variable that controls movement in the

level indicator

Colours for the level indicator when full and

when empty

Orientation

Name labels

Value labels

Values that limit the range of movement from

one end to the other

A value within the limits specified that

determines the level indicator’s increment

Do this

Select it in the Variable list box.

Choose a colour from the appropriate pop-up

menu.

Select Vertical or Horizontal.

Toggle the Name checkbox to show or hide the

names of variables and the Min and Max labels.

Toggle the Value checkbox to show or hide the

values assigned to variables and the Min and

Max labels.

Enter a value in the appropriate Limits text box.

(The defaults are 0 for Minimum and 1 for

Maximum.)

Enter a value in the Step text box.

For example, to increment values by 1, specify 1

as the Step value. To increment by 2, specify 2.

To report intermediate values, specify 0.
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Analog meter properties
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To specify

The variable that controls the

pointer’s movement in the meter

Colours for the pointer and the

background

Minimum and maximum limits for

amplitude

A value that regulates the

pointer’s movement within the

limits specified

Name labels

Value labels

Meter type

Do this

Select it in the Variable list box.

Choose a colour from the appropriate pop-up menu.

Type a value in the appropriate text box.

The defaults for Gauge are 0 and 1; the defaults for

Clock are 0 and 60.

The defaults for Protractor are 0 and 360, if angles

are measured in degrees, or 0 and 6.28, if angles are

measured in radians. 

Enter a value in the Step text box.

For example, to increment values by 1, specify 1 as

the Step value. To increment by 2, specify 2. To report

intermediate values, specify 0.

Toggle the Name checkbox to show or hide the names

of variables and the Min and Max labels.

Toggle the Value checkbox to show or hide the values

assigned to variables and the Min and Max labels.

Select Gauge, Clock, or Protractor.
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Plotter properties
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To specify

The variable that controls the

plotter’s horizontal movement

The variable that controls the

plotter’s vertical movement

Horizontal or vertical scale

Colour for points or line

Thickness of points or line

Name labels

Value labels

Axis

Pencil

Projection lines

Points

Line

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Type a value in the appropriate Scale text box. 

Choose a colour from the Colour pop-up menu.

Choose a thickness from the Thickness pop-up menu.

Toggle the Name attribute checkbox to show or hide the names

of variables.

Toggle the Value attribute checkbox to show or hide the values

assigned to variables.

Toggle the Axis attribute checkbox to show or hide the plotter’s

axes.

Toggle the Pencil attribute checkbox to show or hide the pencil.

Toggle the Projection Lines attribute checkbox to show or hide

projection lines. 

Select Points to draw points instead of a line.

Select Line

to draw a

line instead

of points.
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Digital meter properties
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To specify

The variable value you want to display

The variables that control the location of the

digital meter’s origin

The scale of the digital meter’s vertical or

horizontal movement on the screen

Colour for text (alphanumeric)

Font for text (alphanumeric)

Name labels

Do this

Select the variable in the Variable list box.

Select the appropriate variables in the Origin list

boxes.

Type a value in the appropriate Scale text box. 

The scaling factor should match the scaling

specified for the variable that controls the

origin’s location.

Choose a colour from the Colour pop-up menu.

Click the Font button to open the Font dialog

box, where you specify the font, style, and size

for the text.

Toggle the Name checkbox to show or hide the

names of variables.
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Image importer properties I
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To specify

The variable that controls the image’s

horizontal movement 

The variable that controls the image’s vertical

movement

The scale of the image’s horizontal or vertical

movement on the screen

The variable that controls the horizontal

position of the origin of the image’s axis

The variable that controls the vertical position

of the origin of the image’s axis

Properties affected by variation

The Variation property you select affects some, but not all of the other properties you can specify.

The three tables that follow list the properties that Variation does affect.

Position Variation, which is the default selection, affects the image’s movement in the Animation

window; the image’s size remains static.

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Type a value in the appropriate Scale text box. 

Under Origin, select the appropriate variable in

the Horizontal list box.

Under Origin, select the appropriate variable in

the Vertical list box.
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Image importer properties II
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To specify

The variable that controls the image’s

horizontal size 

The variable that controls the image’s vertical

size

The variable that controls the horizontal

position of the origin of the image’s axis

The variable that controls the vertical position

of the origin of the image’s axis

Size from Lower Left Variation affects how Modellus scales the image’s size in the Animation

window. In this case, the image grows outward from the lower-left corner of its bounding box.

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Under Origin, select the appropriate variable in

the Horizontal list box.

Under Origin, select the appropriate variable in

the Vertical list box.
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Image importer properties III
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To specify

The variable that controls the image’s

horizontal size 

The variable that controls the image’s vertical

size

The variable that controls the horizontal

position of the origin of the image’s axis

The variable that controls the vertical position

of the origin of the image’s axis

Size from Centre Variation also affects how Modellus scales the image’s size in the Animation

window. In this case, the image grows outward from its centre.

Do this

Select it in the Horizontal list box.

Select it in the Vertical list box.

Under Origin, select the appropriate variable

in the Horizontal list box.

Under Origin, select the appropriate variable

in the Vertical list box.
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Image importer properties IV
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Properties not affected by variation

To specify

Image

Image’s name

Name labels

Value labels

Do this

Type or browse for the name of the image file to

import.

Modellus imports the image by reference. Any

change to the pathname you specified when the

image was imported will break the link to the

referenced file.

If you want to change the default name Modellus

assigns to the image, type a new, meaningful

name in the Name text box. 

Toggle the Name attribute checkbox to show or

hide labels, such as the names of variables.

Toggle the Value attribute checkbox to show or

hide labels, such as the values of variables.
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Text properties
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To specify

The variable that controls the horizontal

location of the text’s origin

The variable that controls the vertical location

of the text’s origin

The scale of the text’s vertical or horizontal

movement on the screen

Do this

Under Origin, select the appropriate variable in

the Horizontal list box.

Under Origin, select the appropriate variable in

the Vertical list box.

Type a value in the appropriate Scale text box.
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Geometric object properties I
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In the Geometric Object properties box, follow these general steps.

• Specify the object to add by clicking the appropriate Type.

• If you’re adding points choose the number of points from the pop-up menu and define
their location in the Points Definition dialog box that appears, and then click OK

• If you’re adding a circle, define its centre and another point in the Circle dialog box
that appears, and then click OK.

• If you’re adding segments, define their points in the Points Definition dialog box that
appears, and then click OK.

• If you’re adding a polygon, define its points in the Points Definition dialog box that
appears, and then click OK.

• If you’re adding a line, define two points on that line in the Points Definition dialog
box that appears, and then click OK.
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Geometric object properties II
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To specify

Object type

Number of points

Colour

Thickness of the line segments that "draw"

the shape

The scale of the object’s horizontal or vertical

movement on the screen

The variable that controls the horizontal

position of the origin of the object’s axis

The variable that controls the vertical position

of the origin of the object’s axis

Object’s name

Do this

Select Points, Segments, Polygon, Circle, or Line.

Choose a number from the pop-up menu.

Choose from the Colour pop-up menu.

Choose from the Thickness pop-up menu.

Type a value in the appropriate Scale text box. 

Under Origin, select the appropriate variable in

the Horizontal list box.

Under Origin, select the appropriate variable in

the Vertical list box.

If you want to change the default name Modellus

assigns to the object, type a new name in the

Name text box. 

Giving objects meaningful names is particularly

useful when you decide to join objects.
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Geometric object properties III
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To specify

Name label

Value labels

Axis

Fill for polygon or circle

Trajectory

Tracking, which causes Modellus to display a

trail of image frames at the interval you

specify

Do this

Toggle the Name attribute checkbox to show or

hide the names of variables.

Toggle the Value attribute checkbox to show or

hide the values of variables.

Toggle the Axis attribute checkbox to show or

hide the object’s axes.

Select the Filled attribute. Filled is an option for

polygons and circles. However, when you add

points, segments, and lines, Filled is selected by

default.

Toggle the Trajectory attribute checkbox to show

or hide the object’s trajectory.

Click the Tracking checkbox.

Type the number of steps in the text box.

Tracking is associated with the time step

specified in the Control Options dialog box. Each

image frame in the track is equivalent to a time

step. For example, if the time step is set at 0.1

and you specify tracking at every 10 steps, then

Modellus will show one image per second.
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Computing acceleration
SAMPLE FILES

1
File:

c:\Program files\modellus 2.5\tutorial\05 making a model from data.mdl
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Refraction
SAMPLE FILES

2
File:

c:\Program files\modellus 2.5\tutorial\09 analyzing a photo of a refraction.mdl
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Waves
SAMPLE FILES

3
File:

c:\Program files\modellus 2.5\waves, transversal versus longitudinal.mdl

and so on...



92

Modellus Manual version 2.5 (2002)

The relativistic Doppler shift
SAMPLE FILES

4
File:

c:\Program files\modellus 2.5\dopler.mdl
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Free fall
SAMPLE FILES

5
File:

c:\Program files\modellus 2.5\free fall (e poema para Galileu).mdl
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Functions
SAMPLE FILES

6
File:

c:\Program files\modellus 2.5\common functions in physics.mdl
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1s orbital
SAMPLE FILES

7
File:

c:\Program files\modellus 2.5\orbital 1s with random points.mdl
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Wind and relative velocity
SAMPLE FILES

8
File:

c:\Program files\modellus 2.5\wind, a problem of relative velocity from Tipler.mdl
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Boat in a river
SAMPLE FILES

9
File:

c:\Program files\modellus 2.5\tutorial\14 boat crossing a river with differential equations.mdl
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Oscillation
SAMPLE FILES

10
File:

c:\Program files\modellus 2.5\tutorial\10 an oscillation from data.mdl
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Decay
SAMPLE FILES

11
File:

c:\Program files\modellus 2.5\decay, capacitor data.mdl
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Brownian motion
SAMPLE FILES

12
File:

c:\Program files\modellus 2.5\brownian motion.mdl
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Pendulum
SAMPLE FILES

13
File:

c:\Program files\modellus 2.5\oscillation from a video.mdl
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Chemical reaction
SAMPLE FILES

14
File:

c:\Program files\modellus 2.5\chemical reaction, cyclopropane propene.mdl
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Regression line
SAMPLE FILES

15
File:

c:\Program files\modellus 2.5\tutorial\13 interactive regression line.mdl
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Two-body problem
SAMPLE FILES

16
File:

c:\Program files\modellus 2.5\2 body problem, interactive.mdl
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Velocity is a vector
SAMPLE FILES

17
File:

c:\Program files\modellus 2.5\velocity.mdl
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blank page



“A new scientific truth does not triumph by
convincing  its opponents and making
them see the light, but rather because its
opponents eventually die, and a new
generation grows up that is familiar with
it."

Max Planck

Building and exploring mathematical
models is a fundamental task in science.
Modellus offers students and teachers a
"minds-on," multilevel learning
experience in which they create, simulate,
and analyze models interactively on the
computer, either from experimental
data and images or from pure
theoretical thinking.
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